
COMMUNICATION WITH CLIENTS 
 

1. Which of the following is quick and clear method of communication 
a. e-mail      b. notices/posters 
c. face-to-face informal communication  d. business meetings 
 
2. Which method is good for taking leave in the office. 
a. Website      b. notices/posters 
c. e-mail      d. business meetings 
 
3. Communication starts with: 
a. Encoding      b. Sender 
c. Channel      d. Feedback 
 
4. The number of key elements in the communication process is: 
a. Five       b. Six 
c. Seven      d. Four 
  
5. The information to be communicated in a data communication  
system is the. 
a. Medium       b. Protocol 
c. Message      d. Transmission 
 
 
6. When communicating with clients, what is the primary purpose of establishing clear objectives? 
a. To confuse the client 
b. To create unnecessary complexity 
c. To ensure mutual understanding and alignment 
d. To delay project completion 
 
 
7. What communication channel is commonly used for initial client consultations in graphic design? 
a. Social media messaging     b. Video conferencing 
c. Email        d. In-person meetings 
 
 
8. Which of the following is a key aspect of effective communication with clients in graphic design? 
a. Ignoring client feedback    b. Overpromising and underdelivering 
c. Actively listening to client needs and preferences 
d. Using technical jargon to confuse the client 
 
 
 
9. What is the purpose of setting clear expectations regarding project timelines and deliverables during 
client communication? 
a. To create confusion    b. To ensure project delays 
c. To manage client expectations and avoid misunderstandings 
d. To increase project costs 



10. How do graphic designers typically gather feedback from clients during the design process? 
a. By ignoring client input 
b. By conducting surveys with random questions 
c. By presenting design drafts and seeking client input 
d. By making unilateral decisions without client involvement 
 
11. Which of the following is an example of proactive communication with clients in graphic design? 
a. Waiting for the client to initiate contact 
b. Providing regular project updates without client prompting 
c. Avoiding client meetings and discussions 
d. Ignoring client emails and messages 
 
12. What is the significance of clear and concise written communication when corresponding with 
clients? 
a. To confuse the client with lengthy messages 
b. To create unnecessary complexity 
c. To ensure clarity and avoid misunderstandings 
d. To discourage client engagement 
 
13. During client meetings, what is the purpose of documenting discussions and agreements? 
a. To forget important details    b. To create confusion 
c. To ensure accountability and reference  d. To avoid client satisfaction 
 
14. How do graphic designers typically handle client objections or concerns during communication? 
a. By dismissing client concerns 
b. By addressing them promptly and finding solutions 
c. By escalating the issue without attempting resolution 
d. By ignoring client feedback 
 
15. Which of the following is an example of effective communication to manage client expectations? 
a. Overpromising and underdelivering 
b. Providing realistic timelines and deliverables 
c. Avoiding communication with the client 
d. Making unilateral decisions without client input 
 
16. What role does empathy play in client communication in graphic design? 
a. It is irrelevant in client communication 
b. It helps in understanding client needs and concerns 
c. It leads to increased project costs 
d. It discourages client engagement 
 
17. What is the primary purpose of conducting regular status meetings with clients during a project? 
a. To delay project progress 
b. To confuse the client with irrelevant information 
c. To provide project updates and address any concerns 
d. To avoid client involvement 
 
 



18. How do graphic designers typically seek clarification on client preferences and expectations? 
a. By making assumptions without consulting the client 
b. By avoiding communication with the client 
c. By asking targeted questions and actively listening to client feedback 
d. By ignoring client input 
 
19. Which of the following is a common challenge in client communication for graphic designers? 
a. Overcommunication and information overload 
b. Lack of responsiveness and delayed feedback from clients 
c. Clear and concise communication 
d. Active listening and empathy 
 
20. In graphic design, why is it important to manage client expectations regarding revisions and 
changes? 
a. To discourage client engagement  b. To increase project costs 
c. To avoid client satisfaction 
d. To prevent scope creep and maintain project timelines 
 
21 What is the first step in understanding a client's needs? 
 
a. Sending them an invoice     b. Creating a design mockup 
c. Asking detailed questions    d. Delivering the final product 
 
22. How often should you typically update a client on project progress? 
 
a. Once a year      b. Only at the end of the project 
c. Regularly, based on the project timeline  d. Never 
 
23. What is the best way to handle a client's negative feedback? 
 
a.  Ignore it       b.  Argue with the client 
c.  Listen and make necessary changes   d.  Stop working on the project 
 
24. Why is a design brief important? 
 
a.  It helps in billing the client 
b.  It outlines project goals and expectations 
c.  It replaces the need for client meetings 
d.  It provides legal protection 
  



ENGLISH IN WORKPLACE 

 

1. When encountering a colleague for the first time, the most appropriate greeting is: 

a) A simple nod.    b) A handshake with a smile and introduction. 

c) A casual wave.    d) Ignoring them until they speak first. 

 

2. In a work email, it's best to maintain a tone that is: 

a) Informal and chatty.   b) Professional and courteous. 

c) Vague and unclear.   d) Filled with sarcasm and humor. 

 

3. It's important to be mindful of your body language at work.  Slouching and crossed arms might 

communicate: 

a) Confidence and openness.  b) Disinterest and defensiveness. 

c) Excitement and enthusiasm.  d) Boredom and inattentiveness. 

 

4. How do we communicate verbally? 

a. texting     b. having a conversation 

c. listening to people    d. writing things down 

 

5. Which of the following is included in formal oral communication? 

a. Face to face conversation   b. Telephone conversation 

c. Classroom Lectures    d. Discussion that takes place at business meeting 

 

6. In the design sector, which of the following is considered a common mode of communication for 

sharing project updates and feedback? 

a. Sending emails to clients 

b. Hosting in-person meetings 

c. Using project management software for collaboration 

d. Posting updates on social media platforms 



7. Which of the following communication methods is often used for presenting design concepts to 

clients? 

a. Sending a detailed report via email 

b. Conducting a live video conference call 

c. Sharing a physical portfolio during a face-to-face meeting 

d. Posting updates on a company blog 

 

8. How do designers typically gather requirements and specifications for a new project from clients? 

a. Sending a questionnaire via email 

b. Conducting interviews over the phone 

c. Hosting a focus group session 

d. All of the above 

 

9. Which of the following is an example of informal written communication within a design team? 

a. Sending a formal proposal document to a client 

b. Chatting on a team messaging platform 

c. Drafting a detailed project plan 

d. Sending a company-wide memo 

 

10. During a design project, what is the purpose of conducting regular progress meetings with team 

members? 

a. To share personal anecdotes 

b. To discuss project updates, challenges, and next steps 

c. To critique team members' work publicly 

d. To assign blame for project delays 

 

11. In the design sector, what does the term "client briefing" refer to? 

a. Providing feedback to team members 

b. Presenting project updates to stakeholders 



c. Gathering project requirements and expectations from clients 

d. Conducting internal training sessions 

 

12. Which of the following is an essential skill for effective workplace interaction in the design sector? 

a. Active listening 

b. Avoiding eye contact 

c. Interrupting others 

d. Multitasking during conversations 

 

13. What is the purpose of conducting design reviews within a team? 

a. To critique team members' work without providing constructive feedback 

b. To brainstorm new project ideas 

c. To review project progress and identify areas for improvement 

d. To assign blame for project failures 

 

14. How do designers typically seek clarification on project requirements from clients? 

a. Ignoring client requests 

b. Making assumptions without confirming with the client 

c. Asking targeted questions to gather relevant information 

d. Avoiding communication with clients 

 

15. Which of the following is a common challenge faced during workplace interaction in the design 

sector? 

a. Lack of collaboration and teamwork 

b. Overcommunication and information overload 

c. Clear and concise communication 

d. Limited access to communication tools and platforms 

 

 



16. What is the purpose of providing constructive feedback during design critiques? 

a. To discourage team members from improving their skills 

b. To boost team morale by focusing solely on positive aspects 

c. To identify strengths and areas for improvement in design work 

d. To assign blame for project setbacks 

 

17. In the design sector, how do team members typically collaborate on projects remotely? 

a. Sending physical copies of project files via mail 

b. Using cloud-based collaboration tools and software 

c. Conducting face-to-face meetings only 

d. Avoiding remote work altogether 

 

18. Which of the following is a characteristic of effective workplace communication in the design sector? 

a. Lack of transparency and openness 

b. Unwillingness to seek feedback from stakeholders 

c. Flexibility and adaptability to changing project requirements 

d. Rigid adherence to outdated communication methods 

  



GRAPHIC DESIGN 

1. The balance in a design refers to: 

a. Color harmony.     b. Visual weight distribution of elements. 

c. Use of negative space.    d. Hierarchy of information. 

 

2. Contrast in design helps to: 

a. Create a monotonous feel.    b. Emphasize specific elements. 

c. Blend elements together seamlessly.   d. Reduce visual interest. 

 

3. Hierarchy in design is achieved by: 

a. Using all fonts in the same size and style. 

b. Arranging elements to guide the viewer's eye. 

c. Randomly placing elements on the page. 

d. Keeping all elements equally important visually. 

 

4. Negative space in design refers to the: 

a. Area filled with text.     b. Empty space around and between elements. 

c. Background color of the design.   d. Use of white space excessively. 

 

5. Emphasis in design is used to: 

a. Make all elements equally prominent.   b. Draw attention to specific elements. 

c. Minimize the impact of certain elements.  d. Create a cluttered and busy layout. 

 

6. The Gestalt principles of perception explain how humans: 

a. Interpret visual elements individually. 

b. Organize and group visual elements into a whole. 

c. Focus on negative space only. 

b. Perceive color in isolation from other design elements. 

 



7. Rhythm in design creates a sense of: 

a. Chaos and confusion.      b. Movement and visual flow. 

c. Stagnation and lack of interest.    d. Random placement of elements. 

 

8. Proportion in design refers to: 

a. Use of color palettes only. 

b. The relationship of sizes between elements. 

c. Emphasis on negative space exclusively. 

d. Importance of using contrasting colors. 

 

9. Color psychology suggests that red typically evokes feelings of: 

a. Calmness and peace.      b. Excitement and urgency. 

c. Sadness and loneliness.     d. Sophistication and elegance. 

 

10. Adobe Photoshop is primarily used for: 

a. Vector graphics and illustration. 

b. Raster image editing and manipulation. 

c. Page layout and document creation. 

d. 3D modeling and animation. 

 

11. Adobe Illustrator is known for its capabilities in: 

a. Photo editing and retouching.    b. Creating scalable vector graphics. 

c. Desktop publishing and layout.   d. Web design and development. 

 

12. What is the primary purpose of typography in graphic design? 

a. Adding color to designs 

b. Creating visual hierarchy and readability 

c. Applying textures to artwork 

d. Adding animation effects 



13. Which file format is commonly used for high-quality print graphics? 

a. JPEG       b. PNG 

c. SVG       d. PDF 

 

14. What does the term "RGB" stand for in graphic design? 

a. Red, Green, Blue     b. Realistic Graphic Background 

c. Resolution and Graphics Balance   d. Retro Gaming Board 

 

15. Which design principle focuses on creating a sense of movement and flow in a design? 

a. Balance      b. Unity 

c. Rhythm      d. Contrast 

 

16. What is the purpose of using grids in graphic design? 

a. To add complexity to designs    b. To limit creativity 

c. To create structure and organization   d. To remove color from artwork 

 

17. Which tool in Adobe Photoshop is commonly used for removing unwanted elements from photos? 

a. Brush tool      b. Clone stamp tool 

c. Gradient tool      d. Pen tool 

 

18. Which color mode is primarily used for web-based graphics? 

a. CMYK      b. RGB 

c. Pantone      d. Grayscale 

 

19. What is the purpose of using layers in graphic design software? 

a. To flatten the design      c. To reduce file size 

b. To organize and separate elements within a design d. To apply filters to images 

 

 



20. What does the term "vector graphics" refer to? 

a. Graphics composed of pixels 

b. Graphics composed of mathematical paths 

c. Graphics with limited color palettes 

d. Graphics with transparent backgrounds 

 

21. Which software is commonly used for creating vector-based illustrations? 

a. Adobe Illustrator 

b. Adobe Photoshop 

c. Adobe InDesign 

d. CorelDRAW 

 

22. What does the term "bleed" mean in graphic design? 

a. The process of removing unwanted elements from a design 

b. The area outside the final dimensions of a printed piece where the design extends 

c. The adjustment of colors in a design to create contrast 

d. The alignment of elements in a design 

 

23. What is the purpose of using mockups in graphic design? 

a. To showcase designs in realistic contexts 

b. To create abstract artwork 

c. To add texture to designs 

d. To apply filters to images 

 

24. Which typography style involves slanting the characters to the right? 

a. Italic       b. Bold 

c. Underline      d. Serif 

 

 



25. What is the purpose of using whitespace in graphic design? 

a. To overcrowd designs 

b. To create a sense of balance and separation between elements 

c. To add complexity to designs 

d. To limit creativity 

 

26. What is the purpose of the pen tool in Adobe Illustrator? 

a. To draw freehand shapes    b. To apply color to shapes 

c. To create precise paths and curves   d. To resize objects 

 

27. Which software is commonly used for creating layouts for print publications such as magazines and 

brochures? 

a. Adobe Illustrator     b. Adobe Photoshop 

c. Adobe InDesign     d. CorelDRAW 

 

28. Which file format supports transparency and is commonly used for web graphics with complex 

backgrounds? 

a. JPEG       b. PNG 

c. SVG       d. TIFF 

 

29. What is the purpose of the rule of thirds in graphic design? 

a. To divide a design into equal sections 

b. To add complexity to designs 

c. To create balance and visual interest by placing key elements along imaginary lines 

d. To limit creativity 

 

30. Which software tool is commonly used for retouching and enhancing photographs? 

a. Adobe Illustrator     b. Adobe Photoshop 

c. Adobe InDesign     d. CorelDRAW 



31. What is the purpose of using color palettes in graphic design? 

a. To limit creativity     b. To add complexity to designs 

c. To create harmony and consistency in color choices 

d. To flatten the design 

 

32. Which type of file format is best for storing images with a large number of colors and complex 

compositions? 

a. JPEG       b. PNG 

c. GIF       d. TIFF 

 

33. What is the primary purpose of using mockups in graphic design? 

a. To showcase designs in realistic contexts  b. To create abstract artwork 

c. To add texture to designs    d. To apply filters to images 

 

34. What is the main function of the Bezier tool in graphic design software? 

a. To create freehand shapes    b. To draw straight lines 

c. To create precise paths and curves   d. To apply color to shapes 

 

35. Which typography style does not have extra strokes or lines at the ends of characters? 

a. Serif       b. Sans-serif 

c. Script       d. Display 

 

36. Which of the following is NOT a principle of graphic design? 

a. Proximity      b. Repetition 

c. Replication      d. Alignment 

 

37. What does CMYK stand for in graphic design? 

a. Cyan, Magenta, Yellow, Key    b. Color, Mode, Yield, Kiosk 

c. Cool, Medium, Yellow, Kind    d. Control, Margin, Yield, Keynote 



38. Which file format is best suited for images with transparency? 

a. JPEG       b. PNG 

c. TIFF       d. GIF 

 

39. What is the purpose of the pen tool in graphic design software? 

a. To fill colors in shapes     b. To draw freehand shapes 

c. To create precise vector paths   d. To apply special effects to images 

 

40. What is the purpose of kerning in typography? 

a. Adjusting the space between pairs of letters  b. Changing the font style 

c. Altering the line spacing    d. Adding special effects to text 

 

41. Which color scheme involves using colors that are adjacent to each other on the color wheel? 

a. Analogous      b. Monochromatic 

c. Complementary     d. Triadic 

 

42. What is the purpose of mockups in graphic design? 

a. To create final designs    b. To present design concepts to clients 

c. To resize images     d. To convert files into different formats 

 

 

43. Which typeface category does Helvetica belong to? 

a. Serif       b. Sans-serif 

c. Script       d. Display 

 

44. What is the standard resolution for images intended for web use? 

a. 72 dpi      b. 300 dpi 

c. 600 dpi      d. 1200 dpi 

 



45. What does RGB stand for in graphic design? 

a. Red, Green, Blue     b. Red, Gold, Black 

c. Retro, Gothic, Bold     d. Responsive, Grid-based, Bootstrap 

 

46. Which software is commonly used for vector-based graphic design? 

a. Adobe Photoshop     b. Adobe Illustrator 

c. Adobe InDesign     d. CorelDRAW 

 

47. What is the purpose of a grid system in graphic design? 

a. To add textures to images 

b. To organize content and maintain consistency in layout 

c. To blur edges of images 

d. To create 3D effects 

 

48. Which term refers to the space between lines of text in typography? 

a. Kerning      b. Tracking 

c. Leading      d. Alignment 

 

49. Which of the following is a raster image file format? 

a. SVG       b. EPS 

c. TIFF       d. AI 

 

50. What is the purpose of the color picker tool in graphic design software? 

a. To select and apply colors from an image  b. To resize images 

c. To add special effects to text    d. To create vector shapes 

 

51. What is the purpose of bleed in print design? 

a. To remove unwanted parts of an image 

b. To add extra space around the design for trimming 



c. To adjust the brightness and contrast of an image 

d. To resize the image to fit a specific dimension 

 

52. Which tool in Adobe Photoshop is used for removing unwanted elements from an image? 

a. Brush tool     b. Clone stamp tool 

c. Pen tool     d. Gradient tool 

 

53. What is the purpose of layers in graphic design software? 

a. To save the file in different formats 

b. To organize and manage different elements of a design 

c. To resize the image 

d. To apply filters and effects to the entire image 

 

54. Which of the following is NOT a graphic design principle? 

a. Balance     b. Contrast 

c. Saturation     d. Emphasis 

 

55. What is the purpose of DPI (dots per inch) in graphic design? 

a. To measure the size of the canvas  b. To determine the resolution of an image 

c. To apply special effects to text   d. To adjust the brightness and contrast of an image 

 

56. What is the purpose of the color wheel in graphic design? 

a. To create 3D effects    b. To select complementary colors 

c. To resize images    d. To adjust the brightness and contrast of an image 

 

57. Which term refers to the visual weight of elements in a design? 

a. Alignment     b. Balance 

c. Contrast     d. Hierarchy 

 



58. Which of the following is NOT a type of graphic design? 

a. Web design     b. Animation 

c. Industrial design    d. Illustration 

 

59. What is the purpose of the eyedropper tool in graphic design software? 

a. To resize images    b. To create vector shapes 

c. To select and apply colors from an image d. To add special effects to text 

 

60. The best way to showcase your skills and experience to potential clients as a freelancer is through: 

a. An extensive resume. 

b. A well-designed portfolio website or online platform. 

c. Cold calling businesses. 

d. Sending generic email blasts. Which term refers to the space between letters in typography? 

 

61. ____ refers to the gradient that covers the interior area of an open or closed path. 

a. Color        b. Fill 

c. Stroke       d. Paint 

 

62. What is graphic design? 

   a) Creating visual art for museums 

   b) Designing graphics for video games 

   c) Visually communicating ideas through typography and images 

   d) Designing buildings and architecture 

 

63. What is typography in graphic design? 

   a) The study of color theory 

   b) The arrangement and design of typefaces 

   c) Creating illustrations and drawings 

   d) Editing and manipulating images 



64. Which software is commonly used for image editing in graphic design? 

 a) Adobe Photoshop    b) Adobe Illustrator 

 c) Adobe InDesign    d) Adobe Premiere Pro 

 

65. What is the purpose of color theory in graphic design? 

   a) To create visually appealing designs 

   b) To arrange and design typefaces 

   c) To edit and manipulate images 

   d) To study the history of graphic design 

 

66. What does the term "branding" refer to in graphic design? 

   a) Designing logos and visual identity for a company 

   b) Creating animations and motion graphics 

   c) Editing and retouching photographs 

   d) Designing user interfaces for websites 

 

67. What is the purpose of layout and composition in graphic design? 

   a) To organize and arrange visual elements within a design 

   b) To select appropriate colors for a design 

   c) To create illustrations and drawings 

   d) To manipulate and edit images 

 

68. What is the difference between raster and vector graphics? 

   a) Raster graphics use pixels, while vector graphics use mathematical equations 

   b) Raster graphics are used for print, while vector graphics are used for web 

   c) Raster graphics are scalable, while vector graphics are not 

   d) Raster graphics are created with Adobe Illustrator, while vector graphics are created with Adobe 

Photoshop 

 



69. Which design element helps establish a visual order and guide the viewer's attention? 

   a) Typography      b) Color theory 

   c) White space     d) Composition 

 

70. What is the purpose of wireframing in web design? 

   a) To create high-fidelity visual designs 

   b) To define the layout and structure of a website 

   c) To create animations and interactions 

   d) To optimize images for web use 

 

71. Which software is commonly used for creating vector graphics in graphic design? 

    a) Adobe Photoshop     b) Adobe Illustrator 

    c) Adobe InDesign     d) Adobe Premiere Pro 

 

72. What is the role of a grid system in graphic design? 

    a) To organize and align visual elements 

    b) To choose appropriate color palettes 

    c) To create illustrations and artwork 

    d) To edit and manipulate photographs 

 

73. What is the purpose of mockups in graphic design? 

    a) To showcase designs in a realistic context 

    b) To create animations and motion graphics 

    c) To study and analyze user behavior 

    d) To edit and manipulate typography 

 

74. Which file format is best suited for web graphics that require transparency? 

    a) JPEG      b) PNG 

    c) GIF       d) TIFF 



75. What is the purpose of a style guide in graphic design? 

    a) To maintain consistency in visual elements across designs 

    b) To create complex animations and interactions 

    c) To edit and retouch photographs 

    d) To design user interfaces for mobile apps 

 

76. Which principle of design involves the repetition of visual elements? 

    a) Contrast       b) Alignment 

    c) Repetition      d) Proximity 

 

77. Which of the following allows you to work with non-destructive adjustments in Photoshop? 

a. Flatten Image      b. Adjustment Layers 

c. Eraser Tool      d. Rasterize Layer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SHORT QUESTION 

 

1. What is meant by a courteous manner? 
Ans: Marked by good manners, respect for and consideration of others. 
 
2. Write down the name of five working platform for freelancing? 
Ans: Fiverr, Upwork, Freelancer, Guru, Toptal, 99design, People per hour, 
 
3. What is the term for printing 100% black text on a colored background? 
Ans: CMYK=0%, 0%, 0%, 100% print over colored backgrounds. 
 
4. What color does the following hex value represent? #000000 
Ans: Black 
 
5. What is meant by complementary color? 
Ans: Complementary colors are pairs of colors which, when combined or mixed, by producing a grayscale 
color like white or black. 
 
6. What is the most common DPI for display screen? 
Ans: 72 DPI 
 
7. What is the full name Photoshop's native file format. PSD? 
Ans: Photoshop Documents 
 
8. Name a tool used for drawing path. 
Ans: Pen tool, Curvature Tool 
 
9. What is meant by Contrast? 
Ans: compare in respect to differences. 
 
10. What option in the Character panel will adjust the spacing between in a proportional font? 
Ans: Kerning 
  
11. When you should use Illustrator rather than Photoshop? 
Ans: Adobe Illustrator creates scalable vector graphics. It is best for creating images 
 
12. How do you change Brush size in photoshop using keyboard? 
Ans: Use the bracket keys [ key to decrease the brush size, while pressing] increases the brush size’ 
 
13. Name two types of stationary design. 
Ans: Business Card, Letterheads, Envelop, Notepad, Invoice 
 
14. What is the height of a lower-case letter is called? 
Ans: X Height 
 
 



15. Name two methods of color correction in Photoshop. 
Ans: Level, Hue & Saturation, Curve, Brightness & Contrast  
 
16. What is meant by leading in typography 
Ans: In typography leading is the space between lines of type 
 
17. What color will produce by the values. C=100 / M=0 / y=100 / K=0, CMYK? 
Ans: Green 
 
18. What step you should take to prevent "missing Font Problem" in adobe Illustrator 
 
 
19. What is the most common benefit of PNG file format? 
Ans: PNG files benefit from lossless compression. This means no data is lost when the image is 
compressed 
 
20. What is a common document size for a Letterhead? 
Ans: A4 size (210mm x 297mm, or 8.267″ x 11.693″) is the international standard paper size for 
letterhead,  
 
21. Who will have the design rights after delivering the final product? 
Ans: Client 
 
22. Which operation is used to change text to vector object in Illustrator? 
Ans: Create Outlines 
 
23. Why you should use CMYK color mode for an envelope design? 
Ans: Use CMYK for any project design that will be physically printed, not viewed on a screen. If you need 
to recreate your design with ink or paint, the CMYK color mode will give you more accurate results. 
 
24. What is the full form of pixel? 
Ans: The full form of the pixel is "Picture Element. 
 
25. Why Trim Mark is used in printing? 
Ans: Trim Mark is used in printing to show the printer where to trim or cut the paper.  
 
26. What is Smart Object in Photoshop? 
Ans: Smart Objects are a type of container that holds multiple layers within Photoshop. 
 
27.  What is registration mark in print? 
Ans: Registration marks print outside the trim area of printing 
 

28. What is the difference between raster and vector graphics? 

Answer: Raster graphics are made of pixels and can lose quality when resized. Vector graphics are based 

on paths and can be scaled infinitely without losing quality. 

 



29. What are the primary colors in graphic design? 

Answer: Red, yellow, and blue. These colors can be mixed to create all other colors. 

 

30. What is typography in graphic design? 

Answer: The art and technique of arranging typefaces for visual communication. It includes choosing 

fonts, size, weight, and spacing. 

 

31. What is negative space in design? 

Answer: The empty space around and between elements in a design. It can be used to create balance 

and emphasis. 

 

32. What is the purpose of a logo? 

Answer: A logo is a visual symbol that identifies a company, brand, or organization. 

 

33. What are the Gestalt principles of perception? 

Answer: These principles explain how humans group and organize visual elements into a whole. 

Examples include proximity, similarity, and closure. 

 

34. What is color psychology in graphic design? 

Answer: Studying how colors affect human emotions and behavior. 

 

35. What are some common design tools used by graphic designers? 

Answer: Adobe Photoshop, Illustrator, InDesign, Sketch, Figma, Canva (depending on the specialization). 

 

36. What is the difference between a brochure and a flyer? 

Answer: Brochures are typically folded and have multiple pages, while flyers are single-sided sheets used 

for quick promotion. 

 

37. What is white space in design? 

Answer: Another term for negative space. 



38. What is a mockup in graphic design? 

Answer: A digital representation of a design placed onto a physical object, like a t-shirt or phone case. 

 

39. What is kerning in typography? 

Answer: Adjusting the space between individual letters in a word to improve readability and aesthetics. 

 

40. What is a target audience in graphic design? 

Answer: The specific group of people a design is intended to reach. 

 

41. What is a mood board in graphic design? 

Answer: A collage of images, colors, and textures used to visually communicate a design concept or 

brand identity. 

 

42. What is branding in graphic design? 

Answer: The process of creating a unique visual identity for a company, product, or service. 

 

43. What is a visual hierarchy in design? 

Answer: Using various design elements to guide the viewer's eye to the most important information. 

 

44. What is a client in graphic design? 

Answer: The person or company that hires a graphic designer to create a design project. 

 

45. What is a revision in graphic design? 

Answer: Changes made to a design based on feedback from a client. 

 

46. What is a portfolio in graphic design? 

Answer: A collection of a designer's best work used to showcase their skills and experience. 

 

 



47. What is user experience (UX) design? 

Answer: Designing products and interfaces to be user-friendly, efficient, and enjoyable to interact with. 

 

 

COMMUNICATION WITH CLIENT 

Q: What is the first step in effective client communication? 

A: Understanding the client's needs and expectations. 

 

Q: How often should you update a client on project progress? 

A: Regularly, depending on the project's timeline and complexity. 

 

Q: What is a key skill in managing client feedback? 

A: Active listening. 

 

Q: What should you do if a client is unhappy with the design? 

A: Address their concerns and make necessary revisions. 

 

TEAM WORK 

Q: What is essential for effective teamwork in graphic design? 

A: Clear communication and collaboration. 

 

Q: How can you ensure smooth collaboration with team members? 

A: By setting clear roles and responsibilities. 

 

Q: What tool can facilitate teamwork on design projects? 

A: Project management software like Trello or Asana. 

 

Q: Why is feedback important in a team setting? 

A: It helps improve the quality of work and team performance. 



 

ADOBE PHOTOSHOP 

Q: What tool in Photoshop is used to remove backgrounds? 

A: The Magic Wand tool. 

 

Q: How do you create a new layer in Photoshop? 

A: Click the "New Layer" icon in the Layers panel. 

 

Q: What is the shortcut for duplicating a layer in Photoshop? 

A: Ctrl + J (Cmd + J on Mac). 

 

Q: Which feature is used for non-destructive editing in Photoshop? 

A: Layer masks. 

 

ADOBE ILLUSTRATOR 

Q: What tool in Illustrator is used for creating vector shapes? 

A: The Pen tool. 

 

Q: How can you combine multiple shapes into one in Illustrator? 

A: Using the Pathfinder tool. 

 

Q: What is the shortcut for zooming in Illustrator? 

A: Ctrl + + (Cmd + + on Mac). 

 

Q: How do you create a gradient in Illustrator? 

A: Use the Gradient tool or the Gradient panel. 

 

 

 



FREELANCING MARKETPLACE 

Q: What is a popular freelancing marketplace for graphic designers? 

A: Upwork. 

 

Q: How can you attract clients on a freelancing platform? 

A: By creating a strong portfolio and profile. 

 

Q: What is essential for securing freelance projects? 

A: Effective proposal writing. 

 

Q: How should you price your services on freelancing platforms? 

A: Based on your skills, experience, and market rates. 

 

GRAPHIC DESIGN 

Q: What is the primary purpose of graphic design? 

A: To visually communicate ideas and messages. 

 

Q: What are the basic elements of graphic design? 

A: Line, shape, color, texture, and space. 

 

Q: What principle ensures that design elements are well-organized? 

A: Alignment. 

 

Q: What is the significance of color theory in graphic design? 

A: It helps create visually appealing and effective designs. 

 

 

 

 



COMMUNICATION WITH CLIENT 

 

Q: What is the importance of a design brief? 

A: It outlines project goals, requirements, and expectations. 

 

Q: How should you handle a client's unrealistic deadline? 

A: Communicate the challenges and negotiate a feasible timeline. 

 

TEAM WORK 

Q: What is an effective way to resolve conflicts within a team? 

A: Open communication and finding a compromise. 

 

Q: How do you ensure everyone is on the same page in a project? 

A: Regular team meetings and clear documentation. 

 

ADOBE PHOTOSHOP 

Q: What is the purpose of the Clone Stamp tool? 

A: To copy pixels from one part of an image to another. 

 

Q: How do you adjust the opacity of a layer in Photoshop? 

A: Use the opacity slider in the Layers panel. 

 

ADOBE ILLUSTRATOR 

Q: What is the main function of the Artboard tool in Illustrator? 

A: To manage and organize multiple canvases within a document. 

 

Q: How can you convert text to outlines in Illustrator? 

A: Select the text and choose "Create Outlines" from the Type menu. 

 



FREELANCING MARKETPLACE 

Q: What should you include in your freelancing profile bio? 

A: Your skills, experience, and examples of past work. 

 

Q: How do you build trust with potential clients on freelancing platforms? 

A: By showcasing positive reviews and testimonials. 

 

 

 

 

GRAPHIC DESIGN 

Q: What is the role of typography in graphic design? 

A: To convey information and create visual hierarchy. 

 

Q: What does the principle of contrast do in a design? 

A: It makes elements stand out and improves readability. 

 

Q: Why is white space important in a design? 

A: It creates balance and prevents clutter. 

 

Q: What is the purpose of a style guide in graphic design? 

A: To maintain consistency across different design projects. 

 

COMMUNICATION WITH CLIENT 

Q: What is an effective way to present design concepts to a client? 

A: Use mockups and clear explanations of design choices. 

 

Q: How do you manage a client who frequently changes their mind? 

A: Set clear boundaries and update the project scope accordingly. 



 

TEAM WORK 

Q: How can you foster creativity within a design team? 

A: Encourage brainstorming sessions and an open exchange of ideas. 

 

Q: What is the benefit of using collaborative tools like Slack or Microsoft Teams? 

A: They enhance communication and project coordination. 

 

ADOBE PHOTOSHOP 

Q: How do you save a file for web use in Photoshop? 

A: Use "Save for Web" under the File menu. 

 

Q: What feature in Photoshop allows for precise color correction? 

A: Menu> Image> adjustment. Or Adjustment layer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ICT WORKPLACE 

1. Which of these describes an ongoing pursuit by an individual/group?  

a. Stalking       b. Identity theft  

 c. Phishing       d. Bulling  

 

2. Which one of the following is considered in the category of computer threats?  

a. Soliciting       b. DoS attack  

c. Phishing       d. Both A and B  

 

3. Which of the following typically keeps tabs on every online activity the victim engages in, compiles all 

the data in the background, and sends it to a third party?  

a. Adware       b. Malware  

c. Spyware       d. All of the above  

 

4. Which one is considered to be a type of antivirus program?  

a. Kaspersky       b. Mcafee  

c. Quick heal       d. All of the above  

 

5. Which of these scanners for ports and IP addresses is most used by users?  

a. Cain and Abel      b. Ettercap  

c. Snort       d. Angry IP Scanner  

 

6. Which of the following phrases describes taking someone else's creation or idea and using it for one's 

own advantage?  

a. Intellectual property rights     b. Piracy  

c. Plagiarism       d. All of the above  

 

7. Which of the following describes investigating moral conduct concerning the digital media landscape?  

a. Cyberethics       b. Cyber low  



c. Cybersafety       d. Cybersecurity  

 

8. Determine the earliest method of free phone calls used by hackers.  

a. Cracking       b. Spamming  

c. Phreaking       d. Phishing  

 

9. Which of the following statements best describes how the principle would be broken if a computer 

was no longer accessible?  

a. Confidentiality      b. Access control  

c. Availability       d. All of the above  

 

10. Which of these methods is used to check the validity of a message?  

a. Digital signature      b. Protocol  

c. Message Digest      d. Decryption algorithm  

 

11. Which of the following is typically used when hacking Wi-Fi?  

a. Wireshark       b. Air crack-ng  

c. Norton       d. All of the above  

 

12. Among the following, which is not a form of scanning?  

a. Null Scan       b. Xmas Tree Scan  

c. SYN Stealth       d. Cloud Scan  

 

13. The Code Red is similar to a:  

a. Photo Editing Software     b. Antivirus Program  

c. Video Editing Software     d. Computer Virus  

 

14. Which of these was the first antivirus software ever created?  

a. Reaper       b. Ray Tomlinson 



c. Creeper      d. Tinkered  

15. What kind of malware does not replicate or clone itself through infection?  

a. Rootkits       b. Worms  

c. Viruses       d. Trojans  

 

16. The DNS would convert any domain name into:  

a. Hex        b. Binary  

c.URL        d. IP  

 

17.  The most important step in system hacking is:  

a. Cracking passwords      b. Covering tracks  

c. Information gathering     d. None of the above  

 

18. Which of the following describes the different forms of scanning?  

a. Client, Server, and network     b. Network, vulnerability, and port scanning  

c. Port, network, and services     d. None of the above  

 

19. Determine the attack type that employs a fake server with a relay address.  

a. SMB        b. NetBIOS  

c. NTLM       d. MITM  

 

20. Pick one of the following methods for hiding information inside a picture:  

a. Image Rendering      b. Steganography  

c. Rootkits       d. Bitmapping  

 

21. Choose one of the following strategies to prevent browser-based hacking:  

a. Adware remover in the browser    b. Anti-malware in the browser  

c. Remote browser access     d. Incognito mode in the browser  

22. Which of these is the port number (default) for many web servers, including Apache?  



a. 80        b. 20  

c. 87        d. 40  

 

23. They are malicious hackers whose primary goal is to commit cybercrimes to make money. Who are 

"they" in this context?  

a. White Hat Hackers      b. Black Hat Hackers 

c. Hacktivists       d. Gray Hat Hackers  

 

24. Any company or organization’s IT security is managed and maintained by   

a. IT Security Engineer      b. Security Auditor  

c. CEO of the organization     d. Software Security Specialist  

 

25. What does EDR stand for?  

a. Endless Detection and Response    b. Endpoint Detection and Response  

c. Endpoint Detection and Recovery    d. Endless Detection and Recovery  

 

26. The _______ of a network is assessed using the response and transit times.  

a. Longevity       b. Performance  

c. Reliability       d. Security  

 

27. Which of the following Cyber Security principles limits how privileges are started whenever an object 

or subject is created?  

a. Open-Design       b. Fail-safe Defaults  

c. Least privilege      d. None of the above  

 

28. Which of these conferences was the first one for hackers?  

a. DEFCON       b. OSCON  

c. SECTION       d. DEVON  

 



ILUSTRATOR 

1.What file extension is typically used to save Illustrator documents? 

Answer: .AI (native format) 

 

2. What is the primary difference between vector and raster graphics? 

Answer: Vector graphics (used in Illustrator) are scalable without losing quality, while raster graphics 

(used in Photoshop) are made of pixels and can lose quality when resized. 

 

3. What tool allows you to zoom in and out on your artwork in Illustrator? 

Answer: The Zoom tool (magnifying glass icon) 

 

4. What panel displays a collection of pre-made shapes you can use in your design? 

Answer: The Shapes panel 

 

5. What does the "X" symbol in the toolbar represent? 

Answer: The Reset Selection tool, used to deselect all currently selected objects. 

 

6. What tool is used to create precise lines and shapes with customizable curves? 

Answer: The Pen tools 

 

7. How do you change the color of a filled shape in Illustrator? 

Answer: Select the shape and choose a new color from the Swatches panel or use the Fill tool. 

 

8. What does the Pathfinder panel allow you to do with shapes? 

Answer: Combine and manipulate shapes using functions like Unite, Subtract, and Intersect. 

 

9. What is the Gradient tool used for in Illustrator? 

Answer: To create smooth transitions between two or more colors (gradients) and apply them to shapes 

or backgrounds. 



10. How do you add text to an Illustrator document? 

Answer: Use the Type tool to create a text frame and type your desired text. 

 

11. What panel allows you to control the stacking order of objects in your design? 

Answer: The Layers panel 

 

12. How do you duplicate an object in Illustrator? 

Select the object and press Ctrl + D (Windows) or Command + D (Mac). 

 

13. What is the difference between a stroke and a fill in Illustrator? 

Answer: A stroke defines the outline of an object with a specific color and thickness. A fill applies color to 

the inside area of a closed shape. 

 

14. How can you apply a drop shadow effect to an object in Illustrator? 

Select the object and go to Effect > Shadow > Drop Shadow. 

 

15. What is the purpose of the "Live Paint" feature in Illustrator? 

Answer: Live Paint allows you to convert a path or shape into individual sections that can be filled with 

different colors, creating a painting-like effect. 

 

16. What are symbols in Illustrator and how are they beneficial? 

Answer: Symbols are reusable objects that can be edited and updated in one place, reflecting changes 

across all instances in your artwork. 

 

 

 

17. What is the purpose of using the "Blend" tool in Illustrator? 

Answer: The Blend tool creates a smooth transition between two or more selected objects, generating a 

series of intermediate steps. 

 



18. What is a clipping mask in Illustrator and how does it work? 

Answer: A clipping mask uses one shape to define the visible area of another shape underneath, 

effectively "clipping" the content. 

 

19. What is a "pattern" in Illustrator and how can it be used? 

Answer: A pattern is a repeatable design element that can be applied as a fill to shapes or backgrounds, 

creating seamless patterns. 

 

20 How do you export your Illustrator artwork for use on the web? 

Go to File > Export and choose a format like .SVG or .JPG with appropriate settings for web use. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



MULTIPLE CHOICE QUESTION  

 

1. What is the purpose of kerning in typography? 

    a) To adjust the space between individual letters 

    b) To create animations and motion graphics 

    c) To edit and manipulate images 

    d) To select appropriate typefaces 

 

2. Which design principle focuses on the relationship between elements and their surroundings? 

    a) Balance       b) Contrast 

    c) Proximity       d) Alignment 

 

3. Which design element refers to the visual weight distribution in a composition? 

    a) Hierarchy       b) Contrast 

    c) Alignment       d) Balance 

 

4. Which software is commonly used for page layout and publishing in graphic design? 

    a) Adobe Photoshop      b) Adobe Illustrator 

    c) Adobe InDesign      d) Adobe Premiere Pro 

 

5. What is the purpose of user personas in user-centered design? 

    a) To create illustrations and drawings 

    b) To study and analyze user behavior 

    c) To optimize images for web use 

    d) To select appropriate color palettes 

 

6. What is the role of mood boards in the design process? 

    a) To create high-fidelity visual designs 

    b) To organize and align visual elements 



    c) To define the layout and structure of a design 

    d) To collect and present visual inspiration and concepts 

 

7. What is the purpose of responsive design in web design? 

    a) To optimize images for web use 

    b) To create animations and motion graphics 

    c) To adapt designs to different screen sizes and devices 

    d) To organize and align visual elements 

 

8. What is the purpose of mood lighting in photography? 

    a) To adjust the space between individual letters 

    b) To create complex animations and interactions 

    c) To manipulate and edit typography 

    d) To create a specific atmosphere or mood in a photograph 

 

9. Which design principle involves the arrangement of visual elements along a line or edge? 

    a) Proximity       b) Alignment 

    c) Repetition       d) Contrast 

 

10. What is the role of a grid system in print design? 

    a) To organize and align visual elements 

    b) To create animations and motion graphics 

    c) To edit and manipulate typography 

    d) To optimize images for print use 

 

 

 

 

 



11. What is the purpose of leading in typography? 

    a) To adjust the space between individual letters 

    b) To create complex animations and interactions 

    c) To select appropriate typefaces 

    d) To adjust the space between lines of text 

 

12. Which file format is commonly used for printing high-quality images? 

    a) JPEG       b) PNG 

    c) GIF        d) TIFF 

 

13. What is the purpose of a mood board in graphic design? 

    a) To organize and align visual elements 

    b) To select appropriate color palettes 

    c) To study and analyze user behavior 

    d) To collect and present visual inspiration and concepts 

 

14. What is the role of contrast in graphic design? 

    a) To adjust the space between individual letters 

    b) To create animations and motion graphics 

    c) To create visual interest and emphasize elements 

    d) To select appropriate typefaces 

 

15. Which design principle involves the arrangement of visual elements based on their relationships? 

    a) Balance       b) Proximity 

    c) Hierarchy       d) Contrast 

 

 

 

 



16. Which color mode does a computer monitor use, and which does a printer use?  

  A.  Monitor uses RGB, printer uses CMYK   

  B.  Monitor uses RGB, printer uses RGB  

  C.  Monitor uses CYMK, printer uses RGB  

  D.  Monitor uses CYMK, printer uses Grayscale 

  

17. What is the direct selection tool?  

  A.  Allows the selection of individual shapes  

  B.  Allows the selection of individual lines  

  C.  Allows the selection of individual letters  

  D.  Allows the selection of individual points  

 

18. What does live paint allow you to do?  

  A.  Fill specific areas different colors (Your Answer)  

  B.  Change the color of the whole image at once  

  C.  Draw things freely by hand  

  D.  Remove color from an image  

 

19. Which of these is possible?  

  A.  Using Photoshop to convert raster images to vector images  

  B.  Using Illustrator to convert vector images to raster images   

  C.  Using Bridge to convert grayscale images to vector images  

  D.  Using Dreamweaver to convert gifs into vector images  

 

20. Fundamental transformation tools include all of the following except:  

  A.  Scale        B.  Rotate  

  C.  Reflect        D.  Invert  

 

 



21. What is the area bounded by a solid line in which you create your artwork?  

  A.  Main area        B.  White Zone  

  C.  Artboard        D.  Drawing Zone  

 

22. RGB stands for:  

  A.  Red, Green, Black       B.  Red, Gray, Blue  

  C.  Red, Gray, Black       D.  Red, Green, Blue  

 

23. When working with art work, what is the best practice?  

  A.  There are no best practices when working with art work.  

  B.  Save your work frequently to avoid losing anything. (Your Answer)  

  C.  Work from a copy of the original artwork to avoid destroying the original art work.  

 

24. There are multiple ways to make a backup of the original artwork.  Which of the following choices 

are an acceptable means of preserving the original art work?  (Choose all that apply).  

a. Make a duplicate copy of the file.  

b. In Photoshop, open your artwork and copy the layer, remembering to lock the original layer.  

c. There is no need to make a copy  

d. copying the layer and locking the original is an acceptable option as well.  

 

25. The preferred print resolution is ____ DPI.  

a.  72         b.  150  

c.  300         d. 90 

 

 

 

 

 

 



OPERATE OFFICE APPLICATION 

1. What is the primary function of Microsoft Excel? 

a. Creating and editing text documents    b. Creating and editing presentations 

c. Creating and editing spreadsheets    d. Managing databases 

 

2. Which Office application is commonly used for creating professional presentations? 

a. Microsoft Word      b. Microsoft Excel 

c. Microsoft PowerPoint     d. Microsoft Outlook 

 

3. What is the purpose of Microsoft Outlook? 

a. Creating and editing spreadsheets   b. Managing emails, calendars, and contacts 

c. Creating and editing text documents   d. Designing presentations 

 

4. Which Office application would you use to organize and manage large amounts of data in a database? 

a. Microsoft Excel     b. Microsoft Access 

c. Microsoft Word     d. Microsoft PowerPoint 

 

5. In Microsoft Excel, what function would you use to find the sum of a range of cells? 

a. AVG       b. SUM 

c. MAX       d. MIN 

 

6. Which feature in Microsoft Word allows you to apply consistent formatting throughout a document? 

a. Styles      b. Templates 

c. Font size      d. Page layout 

 

7. A computer program that functions as an intermediary between a computer user and the computer 

hardware is called 

a. software       b. hardware 

c. operating system.      D. driver 



 

8. One or more defects occurring in the computer software that prevents the software from working is 

called 

a. bot        b. system error 

c. bug        d. slug 

 

9. Bug means? 

a Logical error in the program     b. syntax error in the  

c. runtime error       d. All of the above 

 

10. A mistake in an algorithm that generates incorrect results or output is called 

a. logical error       b. syntax error 

c. compile-time error      d. procedural error 

 

11. The process of finding errors/defects/bugs in the software program is called 

a. Debugging       b. Interpreting 

c. Compiling       d. Testing 

 

12. Software programs developed for performing particular tasks related to managing computer 

resources is called 

a. System software      b. Utility software 

c. Application software      d. Helper software 

 

 

13. Which of the following is not a kind of system software? 

a. BIOS software      b. Unix, Linux 

c. Microsoft Windows, and Mac OS    d. Microsoft Word 

 

 



 

14. Which of the following is not application software? 

a. MS-Word       b. Google Docs 

c. Adobe Acrobat      d. Turbo C compiler 

 

16. Application software is developed to accomplish 

a. real-world tasks      b. operating system tasks 

c. computer-centric tasks     d. All of the above 

 

17. Which of the following are known as office-oriented application software? 

a. Interpreters, Compilers, editors    b. Network software, backup system 

c. Word processors, spreadsheets, database   d. Both a and c 

 

18. What is the full form of GUI? 

a. Graphical Universal Interface     b. Graphical User Interface 

c. General Utility Interface     d. General Universal Interface 

 

19. Which among the following application software can be used to create, edit, and print documents? 

a. Spreadsheet       b. Word processing 

c. Database software      d. Desktop publishing (DTP) 

 

20. Which of the following is not a kind of application software? 

a. Word processor      b. Database 

c. Browser       d. Device driver 

 

21. Microsoft Word, Microsoft Excel, and Google Docs are the examples of 

a. an operating software     b. system software 

c. utility software      d. application software 

 



 

 

22. Which application software is used to perform calculations on rows and columns of data? 

a. Word processing      b. Presentation graphics 

c. Database       d. Spreadsheet 

 

23. Which of the following is also known as presentation software that is used to give presentation of 

information and pictures through slideshows? 

a. Multimedia authoring     b. Desktop publishing 

c. Presentation graphics     d. Both b and c 

 

24. Which of the following are examples of presentation graphics software? 

a. Microsoft PowerPoint      b. Apple Keynote 

c. Corel Presentations and Adobe Persuasion   d. All of these 

 

26. Which utility software helps to protect the computer system from viruses and prevent the computer 

system files from being corrupt? 

a. Disk cleanup       b. Disk defragmenter 

c. Antivirus       d. All 

 

27. Which among the following is not a type of utility system software? 

a. Antivirus       b. Firewalls 

c. Disk defragmenter      d. MS-DOS 

 

28. Which utility software is used to protect the computer system from hackers? 

a. Antivirus       b. Firewall 

c. AUP        d. Backup wizard 

 

 



29. Which Office application is primarily used for creating and editing text documents? 

a. Microsoft Excel      b. Microsoft PowerPoint 

c. Microsoft Word      d. Microsoft Access 

 

30. A computer virus that attacks an antivirus program to prevent detection of the virus in the computer 

system is 

a. Worm       b. Retrovirus 

c. Trojan       d. Ghost virus 

 

31. How can you insert a hyperlink in Microsoft Word? 

a. By right-clicking and selecting "Insert Link" 

b. By pressing Ctrl+H 

c. By using the "Hyperlink" option in the Insert tab 

d. By typing the URL directly into the document 

 

32. Which feature in Microsoft Word allows you to create a table of contents automatically? 

a. Styles       b. Templates 

c. Page layout       d. References 

33. What is conditional formatting used for in Microsoft Excel? 

a. To apply consistent formatting to cells b. To highlight cells that meet specific criteria 

c. To create charts and graphs  d. To merge cells in a spreadsheet 

 

 

 

  



PHOTOSHOP RASTER DESIGN 

1.What file extension is typically used to save Photoshop documents with layers preserved? 

Answer: .PSD 

 

2. What is the difference between raster and vector graphics? 

Answer: Raster graphics (used in Photoshop) are made of pixels and can lose quality when resized. 

Vector graphics (used in Illustrator) are scalable without losing quality. 

 

3. What tool allows you to zoom in and out on your image in Photoshop? 

Answer: The Zoom tool (magnifying glass icon) 

 

4. What panel displays a collection of pre-set adjustments you can apply to your image? 

Answer: The Adjustments panel 

 

5. What does the "brush picker" tool represent? 

Answer: This tool allows you to choose and customize the brush you'll use for painting or editing. 

 

6. What tool is used to select a rectangular area in your image? 

Answer: The Rectangular Marquee tool 

 

7. How do you select an irregular shape in Photoshop? 

Answer: Use the Lasso tool (freehand selection) or the Magnetic Lasso tool (follows edges). 

 

8. What does the "feather" option do when selecting an area? 

Answer: It creates a gradual transition between the selected area and the unselected area, resulting in 

softer edges. 

 

9. How do you invert a selection to choose everything outside the currently selected area? 

Answer: Go to Select > Inverse (or press Ctrl + Shift + I on Windows/Command + Shift + I on Mac). 



10. What is a "mask" in Photoshop and its purpose? 

Answer: A mask hides or reveals parts of an image selectively. It can be used for creating cutouts or 

applying effects to specific areas. 

 

11. How do you adjust the brightness and contrast of an image? 

Answer: Go to Image > Adjustments > Brightness/Contrast. 

 

12. What is the "Hue/Saturation" tool used for? 

Answer: To adjust the color hue (tone) and saturation (intensity) of your image. 

 

13. How do you crop unwanted parts of your image? 

Answer: Use the Crop tool and define the desired area to keep. 

 

14. What is the "clone stamp tool" used for? 

Answer: It allows copying pixels from one area of an image to another, useful for removing unwanted 

objects or blemishes. 

 

15. What does the "Content-Aware Fill" tool do? 

Answer: This intelligent tool analyzes the surrounding image content and fills selected areas seamlessly. 

 

16. What is the purpose of using layers in Photoshop? 

Answer: Layers allow independent editing and organization of different image elements. 

 

17. How do you add a new layer to your Photoshop document? 

Click the "Create a new layer" icon at the bottom of the Layers panel. 

 

18. What does changing the "blend mode" of a layer do? 

Answer: Blend modes determine how a layer interacts with the layers below it, creating various effects 

like overlay, multiply, or lighten. 

 



19. How can you apply a drop shadow effect to a layer in Photoshop? 

Double-click the layer in the Layers panel, go to Blending Options > Drop Shadow, and adjust the settings. 

 

20. What are "layer masks" and how do they work? 

Answer: Layer masks are grayscale images linked to a layer. Painting black on the mask hides parts of the 

layer, while white reveals them, allowing for non-destructive editing. 

 

21. How do you add text to a Photoshop document? 

Use the Horizontal Type tool to create a text box and type your desired text. 

 

22. What tool allows you to create basic shapes like squares, circles, or rectangles? 

Answer: The Shape tool 

 

23. How can you change the color of a shape in Photoshop? 

Select the shape layer and choose a new color from the foreground color swatch. 

 

24. What is the difference between a "stroke" and a "fill" for shapes? 

Answer: Similar to Illustrator 

 

25. What is the purpose of the Clone Stamp tool? 

Answer: The Clone Stamp tool is used to duplicate pixels from one part of an image to another. 

 

26. How can you rotate an image in Photoshop? 

Answer: You can rotate an image by selecting the "Image" menu, then "Image Rotation," and choosing 

the desired rotation option. 

 

27. What is the shortcut for the Undo command in Photoshop? 

Answer: The shortcut for Undo is Ctrl + Z (Cmd + Z on Mac). 

 



28. How do you apply a blur effect to an image in Photoshop? 

Answer: You can apply a blur effect by selecting the "Filter" menu, then "Blur," and choosing the desired 

blur filter. 

 

29. What does the Magic Wand tool do in Photoshop? 

Answer: The Magic Wand tool selects areas of similar color or tone in an image. 

 

30. How do you create a new layer in Photoshop? 

Answer: You can create a new layer by clicking on the "New Layer" button at the bottom of the Layers 

panel. 

 

31. What is the purpose of the Pen tool in Photoshop? 

Answer: The Pen tool is used to create precise paths and shapes in Photoshop. 

 

32. How do you adjust the brightness and contrast of an image in Photoshop? 

Answer: You can adjust brightness and contrast by selecting the "Image" menu, then "Adjustments," and 

choosing "Brightness/Contrast." 

 

33. What is the purpose of the Dodge tool in Photoshop? 

Answer: The Dodge tool is used to lighten specific areas of an image. 

 

34. How do you crop an image in Photoshop? 

Answer: You can crop an image by selecting the Crop tool, dragging to define the cropping area, and 

pressing Enter. 

 

35. What is the purpose of the Healing Brush tool in Photoshop? 

Answer: The Healing Brush tool is used to remove imperfections from an image by blending pixels from 

surrounding areas. 

 

 



36. How do you create a selection in the shape of a rectangle or square in Photoshop? 

Answer: You can create a rectangular selection by using the Rectangular Marquee tool. 

 

37. What is the purpose of the Gradient tool in Photoshop? 

Answer: The Gradient tool is used to create smooth color transitions in an image. 

 

38. How do you change the color of an object in Photoshop? 

Answer: You can change the color of an object by selecting it with a selection tool and then adjusting its 

color using adjustment layers or the Hue/Saturation tool. 

 

39. What does the Blur tool do in Photoshop? 

Answer: The Blur tool is used to selectively blur areas of an image. 

 

40. How do you resize an image in Photoshop? 

Answer: You can resize an image by selecting the "Image" menu, then "Image Size," and entering the 

desired dimensions. 

 

41. What is the purpose of the Layers panel in Photoshop? 

Answer: The Layers panel allows you to organize and edit different elements of an image on separate 

layers. 

 

42. How do you apply a filter to an image in Photoshop? 

Answer: You can apply a filter by selecting the "Filter" menu, then choosing the desired filter from the 

list. 

 

43. What is the purpose of the Burn tool in Photoshop? 

Answer: The Burn tool is used to darken specific areas of an image. 

 

44. How do you add text to an image in Photoshop? 

Answer: You can add text by selecting the Type tool, clicking on the image, and typing your text. 



 

45. What is the purpose of the Eyedropper tool in Photoshop? 

Answer: The Eyedropper tool is used to sample colors from an image. 

 

46. How do you change the brush size in Photoshop? 

Answer: You can change the brush size by pressing the "[" key to decrease the size or "]" key to increase 

the size. 

 

47. What is the purpose of the Smudge tool in Photoshop? 

Answer: The Smudge tool is used to blend and smear colors in an image. 

 

48. How do you adjust the levels of an image in Photoshop? 

Answer: You can adjust levels by selecting the "Image" menu, then "Adjustments," and choosing 

"Levels." 

 

49. What does the Eraser tool do in Photoshop? 

Answer: The Eraser tool is used to erase parts of an image or layer. 

 

50. How do you create a new Photoshop document? 

Answer: You can create a new document by selecting the "File" menu, then "New," and entering the 

desired dimensions and settings. 

 

51. What is the purpose of the Clone Source panel in Photoshop? 

Answer: The Clone Source panel allows you to specify settings for the Clone Stamp tool, such as the 

source point and alignment. 

 

52. How do you adjust the opacity of a layer in Photoshop? 

Answer: You can adjust the opacity of a layer by using the Opacity slider in the Layers panel. 

 

 



53. What is the purpose of the Path Selection tool in Photoshop? 

Answer: The Path Selection tool is used to select and manipulate paths created with the Pen tool. 

 

54. How do you save an image in Photoshop? 

Answer: You can save an image by selecting the "File" menu, then "Save As," and choosing the desired 

file format and location. 

 

 

 

 

MULTIPLE CHOICE QUESTION 

31. Below select any of the raster software? 

a) Adobe Illustrator      b) Adobe Photoshop 

c) Adobe InDesign      d) Corel Draw 

 

32. What is the unit of Resolution? 

a) Pixels per Inch      b) Pixels per Square 

c) Pixels        d) None of the Options 

 

33. Which Color mode is used to Design Websites? 

a) CMYK       b) RGB 

c) Lab Color       d) Multichannel 

 

34. Graphic Designer should have knowledge of 

a) Design Process      b) Design Principles 

c) Trends in Industry      d) All of the Above 

 

 

 



35. Graphic Designer need the skills to 

a) Edit Image       b) Design Mockups 

c) Branding       d) All of the Above 

 

36. Rectangle Properties contains 

a) Pie and Arc       b) Number of Sides 

c) Round Corners      d) Alternate Nodes Move 

 

37. What is the Standard size of Visiting Cards 

a) 10 X 5 Centimeters      b) 5 X 4 Inches 

c) 3.5 X 2 Inches      d) 3 X 4 Inches 

 

38. What is MS Excel 

a) Spreadsheet       b) Database Management 

c) Presentation       d) Workbook 

 

39. Which software is used for presentation 

a) Prezi        b) Safari 

c) Google .doc       d) Workbook 

 

40. Raster images saved in RGB color mode should never be used for 

a. Printing       b. PowerPoints Presentations 

c. Email        d. Newsletters 

 

41. When would it be best to use Illustrator rather than Photoshop? 

a. Image editing and when manipulating photos 

b. Either one is just as good 

c. Creating scalable graphics or when optimizing vector images 

d. When its requested 



 

42. Colors that are opposite of each other are called? 

a. Square       b. Complementary 

c. Analogous       d. Split-Complementary 

 

43. What is negative space? 

a. Vector shapes that have no color assigned.   b. The reduced space between words. 

c. The space around and between the subject(s) of an image. 

d. A mirrored image 

 

44. In Photoshop, you can change text to a graphic by- 

a. Convert Text       b. Render Text 

c.  Rasterize Text      d. Outline Text 

 

45. Which of the following is not an image file extension? 

a. .ai        b. .jpg 

c. .tiff        d. .bmp 

 

46. What is the actual size of a A4 size paper? 

a. 8" x 1O"       b. 8.267" x 11.692" 

c. 9" x 17"       d. 9.5" x 11" 

 

47. Which one of the following is a Word processor? 

a. MS        b. Google 

c. Google docs       d. Firefox 

 

48. Which one of the following is a computer Peripherals? 

a. Modem       b. Software 

c. Hard disk       d. USB port 



 

49. Which one of the following is a working platform for freelancing? 

a. Guru        b. Gorila.com 

c. Georgia       d. Upwork.com 

 

50. Which one of the following is an online Channels of communication? 

a. Zoom       b. Effective questioning 

c. Local authority      d. Letter 

 

51. Which one of the following is a courteous manner? 

a. Direct roughly      b.  Active listening 

c. Too much questioning     d. Always Showing rules and regulations 

 

52. Which one of the following is not a Workplace ace document? 

a. Directions       b. Emails 

c. Regulations       d. Workforce 

 

53. Which one of the following is a method of communication? 

a. Email address      b. Banner ads 

c. Letter head       d. Search engine 

 

54. Which file format is the most widely used when saving a rastered image for printing? 

a. TIFF        b. JPG 

c.  GIF        d. PNG 

 

55. C=O I M=100 I Y=100 I K=O, CMYK values, will produce what color?? 

a. Blue        b. Green 

c. Black        d. Red 

 



56. Pantone is? 

a. Hex color values      b. Illustrator color values 

c. A proprietary color spaces     d. Photoshop color value 

 

57. In typography, kerning is stand for-? 

a. the distance between the baselines of successive lines of type 

b. the process of adjusting the spacing between two characters 

c. the process of selecting a typeface for a paragraph style 

d. the process of uniformly increasing or decreasing the space between all letters in a block of text 

 

58. What is a typography serif?? 

a. A detail on the end of a letter's stroke 

b. A typeface that looks handwritten 

c.  Letters that are formed from character pairs 

d. Letters that fall below the baseline 

 

59. What does the printer use to know where to trim the paper after printing? 

a. Crop Marks       b. A Ruler Color  

c. Bars        d. Registration Marks 

 

60. What color does the hexadecimal code #FFFFFF make? 

a. blue        b. red 

c. White       d. black 

 

61. What does the A in RGBA stand for?? 

a.  alpha-numerical      b.  aliasing 

c.  alpha       d. opacity 

 

62. How many digits are in a hexadecimal color code?? 



a. 4        b. 6 

c. 8        d. 3 

 

63. Which of the following describes "anti-aliasing"? 

a. Removal of errors and bad pixels from a low-res image. 

b. A smooth edge or transition of pixels around a graphic, so it's not jagged. 

c. Editing to take out the image's EXIF data. 

d. A rough placeholder graphic that will be replaced before printing with a high- res version. 

 

64. What would you call a grayscale image when printing off set?? 

a. Halftone art       b. Split fountain art 

c. Line art       d. Color art 

 

65. Photoshop is a product of -? 

a. Mac        b. Adobe 

c. Macromedia        d. Apple 

 

66. Raster\Which of the following is considered the industry standard for photo manipulation in graphic 

design? 

a. Dreamweaver       b. Paint 

c. Photoshop       d. Acrobat 

 

67. Which type of graphic can be infinitely rescaled \Without loss of resolution? 

a. Vector       b. Pointilated 

c. Pixelated       d. Rasterization 

68. 20. What color does the "K" in CMYK stands for? 

a. Blue        b. Black 

c. Magenta       d. Red 

69. Which statement of the following is the best describes Photoshop and Illustrator? 



a. Photoshop is web, Illustrator is print 

b. Photoshop is CMYK, Illustrator is Monotone 

c. Photoshop is raster, Illustrator is vector 

d. Photoshop is vector, Illustrator is raster 

 

70. HSL, one of the color-control options often found in software stands for: 

a. Hue, Saturation, Lightness     b. Hue, Softness, Lightness 

c. Highlights, Saturation, Lowlights    d. Height, skin tone, language 

 

71. What is a watermark? 

a. A translucent mark that is mostly only visible when held up to light 

b. A stain that accidentally happens during printing 

c. Where the paper cutter will trim the page 

d. A special plate the embosses plastic into paper 

 

72. Which one of the following does not stand f or typographic hierarchy? 

a. Placement       b. Contrast 

c. Point size       d. Depth of field 

 

73. Which of the following terms is use for describing the resolution 

of an image? 

a. time, space. or di tant.     b. pixels, dots, or lines per inch. 

c. height, weigl1t, or length.     d. feet, inches, or yards. 

 

73. Which one of the following is a serif font? 

a. Century Gothic      b. Arial 

c. Georgia       d. Time new Roman 

 

TEAM WORK 



1. What is a key step in Teamwork? 

a. Leadership       b. Responsibility 

c. Organization      d. All of the above 

 

2. What does Teamwork mean? 

a.To work well with others     b.To work hard 

c.To Communicate well     d.To work using skills 

 

3. How do you use teamwork in your everyday life? 

a. Help an old lady across the street   b. Walk someone to class 

c. Work with student to get and assignment done d. A and B 

 

4. What is not an important factor in teamwork? 

a. The team must receive external support and encouragement 

b. The team must have a results-driven structure 

c. The team must not help their team member 

 

5. What do you mean by teamwork? 

a. Setting out alone 



b. Taking control of the team to do your work 

c. Working with the team to get what everyone 

d. Creating problem for everyone  

 

6. What is a characteristic of a strong team leader? 

a. Micromanages every aspect of the project. 

b. Encourages open communication and participation from all team members. 

c. Takes all the credit for the team's success. 

d. Avoids conflict at all costs, even when necessary. 

 

7. What is a positive consequence of a diverse team? 

a. Limited perspectives on solving problems. 

b. Increased creativity and innovation. 

c. Difficulty reaching consensus on decisions. 

d. All of the above (both b & c) 

 

8. Self-directed teams often require: 

a. Micromanagement from a leader to ensure tasks are completed. 

b. Clearly defined goals and performance metrics for the team. 

c. Limited access to resources and information. 

d. A rigid hierarchy with clear reporting structures. 

 

9. A group of people working with common objectives or goals is known as a _________ 

a. Team       b. Teamwork 

c. Group       d. Club 

 

 

10. Which of the following is not a benefit of teamwork? 

a. Improved solutions to quality problems b. Improved ownership of solutions 



c. Improved communications   d. Decline in integration 

 

11. Which of the following is not a classification of a team? 

a. Process improvement team  b. Cross-functional team 

c. Natural work team   d. Group-directed/group-managed work team 

 

12. Cross-functional teams are _______ 

a. Temporary      b. Permanent 

c. Neither Temporary nor Permanent  d. Either Temporary or Permanent 

 

13. The person from the quality council who provides support to the organization is known as ________ 

a. Sponsor      b. Customer 

c. Founder      d. Manager 

 

14. Which of the following is not a characteristic of a successful team in an organization? 

a. Appropriate Leadership    b. Balanced Participation 

c. Cohesiveness     d. Mutual enmity 

 

 

 

15. In a self-directed team, what is the primary responsibility of team members? 

a. Follow strict instructions from team leaders 

b. Work independently without any guidance 

c. Collaborate with team members to achieve goals 



d. Rely solely on the team leader for decision-making 

 

16. What does autonomy mean in the context of a self-directed team? 

a. Working without any supervision 

b. Having the freedom to make decisions 

c. Following instructions from higher management 

d. Following a strict set of rules and guidelines 

 

17. What is a characteristic of effective communication within a self-directed team? 

a. Limited interaction among team members 

b. Clear and open communication channels 

c. Relying solely on written communication 

d. Avoiding communication with team leaders 

 

18. How do self-directed teams typically handle conflict resolution? 

a. Ignoring conflicts until they escalate 

b. Seeking guidance from higher management 

c. Addressing conflicts collaboratively within the team 

d. Assigning blame to individual team members 

19. What is the role of leadership in a self-directed team? 

a. Micro-managing team members' tasks 

b. Facilitating collaboration and providing support 

c. Making all decisions without input from the team 

d. Assigning tasks without considering team members' strengths 



 

20. How do self-directed teams promote innovation and creativity? 

a. By following rigid procedures and protocols 

b. By encouraging experimentation and risk-taking 

c. By limiting autonomy and freedom of expression 

d. By discouraging collaboration among team members 

 

21. Which of the following best describes the level of accountability in a self-directed team? 

A) Individual team members are not accountable for their actions 

B) Accountability is solely placed on the team leader 

C) Each team member is accountable for their contributions 

D) Accountability is only relevant during team meetings 

 

 

 

 

 

22. What is a benefit of working in a self-directed team? 

A) Limited opportunities for skill development 

B) Increased sense of ownership and responsibility 

C) Decreased collaboration and teamwork 

D) Lack of flexibility in task assignments 

 

23. How do self-directed teams contribute to employee satisfaction? 



a. By imposing strict rules and regulations 

b. By providing limited opportunities for growth 

c. By allowing team members to have a say in decision-making 

d. By discouraging autonomy and independence 

 

24. Which of the following is a key factor in the success of a self-directed team? 

a. Lack of communication among team members 

b. Consistent monitoring and supervision from higher management 

c. Trust and mutual respect among team members 

d. Dependence on the team leader for all decisions 

 

26. What is the primary goal of a self-directed team? 

a. Completing tasks without collaboration 

b. Maximizing individual achievements 

c. Achieving shared goals through collaboration and autonomy 

d. Following directives from higher management 

27. How do self-directed teams handle goal setting and task allocation? 

a. By assigning tasks based on individual preferences 

b. By collectively setting goals and distributing tasks among team members 

c. By relying solely on the team leader to set goals and allocate tasks 

d. By following a rigid hierarchy in task allocation 

 

28. Which of the following best describes the decision-making process in a self-directed team? 

a. Decisions are made solely by the team leader 



b. Decisions are made through consensus among team members 

c. Decisions are imposed without input from team members 

d. Decisions are made based on individual preferences 

 

29. How do self-directed teams foster a culture of continuous improvement? 

a. By discouraging feedback and suggestions from team members 

b. By implementing rigid processes that limit innovation 

c. By encouraging reflection, experimentation, and learning from mistakes 

d. By relying solely on external consultants for improvement initiatives 

 

 

 

 

 

30. What role does feedback play in the functioning of a self-directed team? 

a. Feedback is only provided by the team leader 

b. Feedback is ignored by team members 

c. Feedback is actively sought and used for improvement 

d. Feedback is discouraged to avoid conflicts 

 

31. How do self-directed teams adapt to changes and challenges? 

a. By resisting change and maintaining the status quo 

b. By seeking guidance from external sources 

c. By collaborating to find creative solutions 



d. By relying solely on the team leader for direction 

 

32. What is the significance of trust within a self-directed team? 

a. Trust is irrelevant in a self-directed team 

b. Trust fosters collaboration and cooperation among team members 

c. Trust is solely based on the authority of the team leader 

d. Trust limits autonomy and independence among team members 

 

33. How do self-directed teams ensure accountability for project outcomes? 

a. By blaming external factors for failures 

b. By assigning blame to individual team members 

c. By collectively taking responsibility for successes and failures 

d By relying solely on the team leader for accountability 

34. What is the primary advantage of a self-directed team over a traditional hierarchical team structure?  

a. Increased dependence on the team leader for decision-making 

b. Limited opportunities for collaboration and innovation 

c. Greater autonomy and flexibility in decision-making 

d. Reduced accountability for individual contributions 

 

35. What is the primary benefit of effective teamwork in graphic design? 

a. Individual recognition     b. Increased productivity 

c. Higher costs      d. Less communication 

 

36. Which tool is commonly used to facilitate collaboration among team members? 



a. Adobe Photoshop     b. Microsoft Word 

c. Trello       d. Microsoft Excel 

 

37. What is an essential characteristic of a successful design team? 

a. Hierarchical structure     b. Clear communication 

c. Individual work      d. Competition among member 


